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Installation and License 
 
 
To install the program, run the downloaded “GrooveDetectiveSetup.exe” application. 
Groove Detective requires some additional system components to run, which in some 
rare cases may not be present on the machine. These are available for download on the 
“Download” page at www.cpuproductions.com. 
 
The program comes with a built-in free 30 day trial.  
 
After you have purchased a license, you will receive an Activation Key via email. Enter 
this key into the Activation Key fields in the “Activate new license” section and click 
Activate (you must be connected to the Internet for this process).   
 

 
 
You should get a message confirming that your license has been activated. 
 

 
 
See the section on License Center for more information on how to manage your license. 
 

Data folder 
 
The main application files will be installed in the folder you chose during installation. 
These are the files you will never need to worry about. 
 
Everything else will be placed in a DATA folder that is fixed at installation time. An 
option to change this location will be added in a future release. 

http://www.cpuproductions.com/
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This folder will be the home for the database that you will create, so it is important that 
you know where it is, so you can back it up. We’ll say it again: BACK UP this database as 
part of your regular backup routine (it takes a lot of time to recreate it if you have a 
large loop collection). 
 
On Windows XP this folder is usually 
 
“\Documents and Settings\<user name>\Application Data\Groove Detective” 
 
On Windows Vista and Windows 7 it is usually 
 
“\Users\<user name>\AppData\Roaming\Groove Detective” 
 
If you can’t find any of these locations, do a search on “Groove Detective” in Windows’ 
Explorer. 
 
The Data folder also contains all the sound files that the program uses, all of which you 
can substitute with your own or add to. Details of this are explored later in this manual. 
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Introduction 
 
 
If you’re like most musicians, producers, hobbyists and others who use a computer to 
make music, you have probably collected (or will soon) a large number of audio loops, 
use of which has become so important in modern music-making. Chief among these are 
drum and percussion loops that can give a professional touch in the rhythm 
department. 
 
But as your collection grows, so does an accompanying problem: how do you find that 
specific rhythm pattern, the ‘groove’, which you have in mind for the song you’re 
writing or recording? Chances are 99.9% that you won’t have taken the time to organize 
the loops yourself every time a new batch lands on your drive. Individual collections you 
buy are often quite sensibly organized into styles, tempo and so on, but always in self-
contained folders apart from everything else you have. There is no agreed-upon system 
of doing this, so you still end up with the items you’re interested in spread across 
dozens and hundreds of folders. 
 
Out of our own growing frustration with this problem of having so many great musical 
resources available, but no effective means of accessing most of it, Groove Detective 
was conceived and, now, it’s finally here! 
 
In a nutshell, Groove Detective analyzes the sound of all the loops in your library and 
puts the resulting information into a database, which you can then search for rhythm 
patterns, sound similarity and more. Once you have found a loop you like in the search 
results, you can drag-and-drop it into a track in your DAW (Digital Audio Workstation) 
or, if the app doesn’t support that, navigate to the specified folder and pick it up there. 
 
How does GD let you provide the search data? You can read all about that in the 
manual, but if you know how to use a drum machine or equivalent, you will have no 
problem searching your loops with GD! 
 
When you have the inspiration: don’t dread having to listen to hundreds of loops before 
you give up and just go with the ones you’ve used so many times before and know 
where to find. Discover your collection – for the first time! 
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Getting started 
 
Welcome and thank you for trying or buying Groove Detective! The only software that 
lets you quickly find the groove you’re looking for from thousands of loops. 
 

Analyze 
 
Before you can do anything with the program you have to analyze your loops and build 
a database for Groove Detective (GD) to work with. The first time you run the program 
you will see the following message: 
 

 
 
 
 

 
First, you need to tell it where to find the loops you want in 
your database. Go to the File/Options/Files page. 
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Check the file-types you want to include and use the Browse and ADD buttons to add 
folders to search in. 
 

Acid files are included in the WAV type and Apple Loops are included in the AIF 
type. 
 

Next, go to the Analyze menu and select Analyze All. 
 
The analysis will start and you will see this status window 
for as long as GD is working on it: 
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Analysis takes on average 1 second per file on a typical machine anno 2010. If 
you have thousands of loops and you included all of them in the search folders, 

this process can take many hours to complete. If you want to quickly try the various 
features of the program, make sure to start off with just a few hundred loops.  
 
The analysis process is designed to use as much of the CPU as possible, so you shouldn’t 
count on being able to use the computer for anything else while this is going on. Your 
best bet is to start it off as you close down for the day and then, hopefully, the next 
morning it will all be done. 
 

If you have the MIDI only version of the program, then all of the above is not 
usually relevant. At least a 1000 Midi loops can be processed per a few seconds 
normally.  

 
As it is stated on the status window, you can stop the analysis at any time and pick it up 
again later, without losing any data. 

Search 
 
Once you have built the database, you can start searching for rhythm patterns 
using the sequencer-like pattern edit window. The full details of this sequencer are 
described below. For now, choose the Match (or “must have”) tool and place hits 
on the grid.  
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Use the playback buttons to audition your pattern.  
 
When you’re satisfied, hit the Search button and see how many loops you have that 
match that pattern. 
 

 
 

 
 

…and play 
 
You can filter and sort this list in various ways. This is described in detail below. Audition 
the loops until you find one you want to use and then simply drag it into a track in your 
main DAW and you’re good to go! 
 
To drag, select either the file name or the file path and then use the standard OS 
dragging method. 
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Operations 
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Setting Options 
 
 

Go to the File/Options menu item to open the Options dialog. 

 

 

 

Search Folders 
 
Refer to the Getting Started section. 
 
You can choose any path that appears in the browser, including network paths. When 
using the latter, make sure that no folder is the parent or child of another path you have 
added. This is checked for on local paths, but not on network paths, which could result 
in duplicated entries in your database. 
 

File Types 

 
You can check any of the available file-types on or off for inclusion in the database 
analysis.  
 

 
 
WAV: Any format, including ACID loops (Windows mostly) 
AIF: Any format, including APPLE LOOPS (Apple mostly) 
AU: Unix/Linux sound files, any format 
REX: REX, RX2 or RCY files, any format (Propellerheads) 
MP3, WMA: Any format 
MIDI:   Standard Midi Files, type 0 or 1  
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Audio 
 
To set the available audio output options and your current driver, choose the Audio tab. 
 

 
 
A list of available DirectX drivers will appear. Select the one you want and click on Select 
and that’s it. 
 
Currently, only DirectX is supported for audio (see FAQ).  
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Midi 
 

To set the available Midi input options, choose the Midi tab. 
 

 
 
A list of available Midi inputs will be displayed. Click on the one you want and then click 
on Select.  
 
 Midi input channel : select channel for all live input. 
 
Active in Analysis 
Analysis database: When GD is analyzing your Midi loops, it will only look at tracks that 
have its Midi channel activated here. Click on the channels you want included or click All 
for every channel. 
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Database and Analysis 
 
You will get various messages as the program starts up if your database does not exist, it 
is not current or there is something wrong with it. These conditions are reflected in the 
Analysis Menu. 
 

If the database for some reason disappears or becomes 
unusable, all searches will be disabled and the 
Analyze/Analyze All menu item will appear in red. 
 
 

 
At this point your only option is to select this menu item and start a full analysis. 
 

If, however, you have just added more stuff to your library, 
your existing database will still work fine, but it won’t have 
all your newly acquired files in it. In this case, Analyze All 
will turn yellow and the Update Database item will be 
enabled. This will also happen if you have deleted or 

renamed files or folders or changed the folders structure in any way. 
 
To make your database current, select Update Database, as that will only analyze the 
new additions to your search folders (and/or delete database entries) and leave 
everything else as is. 
 

During an Update operation you may notice that some old files were analyzed 
again. Groove Detective does not keep a comprehensive ledger of everything 
that’s in the search folders, so it always tries to err on the side of caution in 

cases where it’s not clear whether something was new or not. 
 

If some of your search folders are on a network path and that path is not 
currently available, you may get a notice that your database is not current. If you 
know this to be the case, you can safely ignore this message. 

 

 



Common GUI Elements Page 18 

Common GUI Elements 
 

 
When the cursor is over the Waveform display or the Pattern Edit window, the absolute 
time and the relative bar position of the cursor will be displayed in the status bar at the 
bottom. 
 

The number to the left shows time in milliseconds and the one 
to the right shows time in Bar : 4th-note : 16th-note : PPQ 
 
 
 

 
For both of those windows, zoom and scrolling 
are available. 

 
When you open a dialog for loading either a sound file, a Midi file or a Pattern file (.gdh 
files) that can be played, you will see an extra addition to the dialog that lets you 
audition the files as you browse. 
 

 
 

 
The controls are, left to right: 

 Auto Play. If this is checked, any time you select a new file in the browser, it will 
start to play. 

 Play button. Starts playing the currently selected file. 

 Stop button. Stops playing the currently selected file. 

 Volume slider. 

 Load Bar #. This is only active when loading a Midi file. Since the Pattern Editor 
can only hold one bar at a time, you have to tell it which one to load. 

  
When auditioning Midi files, sometimes nothing will happen when you click Play. This 
occurs when the Midi file has no drum hits on the Midi channels you specified on the 
Options page.
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Waveform Display 
 
The Waveform Display serves many different functions. At its core, it is just another 
display of a sound-file.  
 
Click on the File Open button and load any supported file-type. 
 

 
 
Use the transport buttons to play, stop and rewind. Use the zoom-control to the right to 
drill into the details of the waveform and use the scroll-bar and the left mouse-button to 
position the view and play-cursor. 
 
You can start and stop playback with the right mouse button any time the cursor is over 
the waveform. If a bar is selected then playback will always start from the beginning of 
the selection. Otherwise, it will start from the position of the cursor. 
 
When you load a sound file, the program is going to make an educated guess as to 
whether it is a fully mixed song or a loop or sound segment that could be used in a 
production situation. 
 
If it is deemed to be the latter and it can latch on to events of a percussive nature then it 
will analyze the waveform for hits and make an estimate of tempo and bar duration. 
 

 
 
The green vertical lines are Bar Lines as determined by the analysis algorithm. This 
display serves two purposes: 
 

1. You can use it to input hits to the Pattern Editor. 
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2. And at the same time, you can check that it’s doing what you think it should be 
doing, figuring out the bar boundaries. 

 
 
To transfer a bar to the Pattern Editor do this: 
 

 Double-click inside one of the bars – it will be selected. 
 

 
 

 
 
 
 
 

 Click the SendTo button, which will now have been activated and turned green. 
 

 
 
The analysis of that particular bar will now be displayed in the Pattern Editor: 
 

 
 
You have to set Quantize to OFF to get the actual reading of the analysis (more on this in 
the Pattern Control section). 
 
If you think the analysis has made a mistake in figuring out the bar lines, there’s a fix for 
that. This will only make a difference in the editor, not in the Database creation.  
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Bar Edit 
 

If you are not satisfied with where the bars were 
automatically placed, you can change them. Select 
Remove Bar Line & Markers on the Edit menu. 
 
 

 
All automatically determined bar boundaries will be removed. At the same time 
the Bar Marker Set option will be activated. 
 
 

Click on it to create a new Bar Marker. The Marker will follow the mouse around as long 
as it is over the waveform. To place the Marker: click the left-button.  
 
 

 
 
 
You can double-click to select a bar, just as with the automatic bar lines: 

 
 
 
 
 
 
 
 
 

Then proceed as in the above example. 
 

If a loop contains only one bar, then Send To and Bar Marker Set will be 
activated automatically. 
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Edit Bar Markers 
You can move manually placed Bar Markers at any time. When the mouse hovers over 
the triangular handle, it will turn into a “Hand” cursor. Left-click and move the Marker to 
where you want it.  If the resulting bars are either too short or too long according to the 
minimum and maximum tempo settings (fixed to 30 and 300 bpm currently), the marker 
will either not move or refuse to be placed.
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Pattern Editor 
 
The Pattern Editor lets you create a pattern of drum hits, which will be the source for 
your loop searches. It contains exactly one bar with a time signature of 4/4. See the FAQ 
for further comments on this. 
 
You can specify hits for three “instruments”: kick drum, snare drum and hi-hat. These 
designations are mostly meant as guidelines as the analysis is more generally focused on 
the frequency range, rather than identifying specific instruments. So, alternatively, you 
can think of them as low, mid and high frequency instruments, respectively. 
 

When describing searches, the pattern in the editor is referred to as the “Target” 
and any patterns in the database are referred to as “Candidate”. 
 

Pattern Control Section 
 
At the top of the Editor subwindow you will find the Pattern Control Section.  
 

To load an existing Pattern or MIDI file, click on the File Open button. Pattern 
files have the extension “gdh” on a PC. 
 

 
When there is something in the edit window, you can save it as a pattern file 
with the File Save button.  
 

 
To play, stop and record, use the transport buttons. 
The Record function will be explained further below. 
 

 
To change the playback tempo, type it into the Tempo edit box, or select it 
and then use the mouse scroll wheel to change it in 0.5 increments. 
 

 
You can change the quantization grid by clicking on the Quantize drop-down menu. 
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The first option “OFF” turns all quantization off. Next, there are three 
groups of values. The first is ‘straight’, the second is ‘triplet’ (T) and the 
third is ‘dotted’ (D), i.e. the actual grid-value is duration + half of duration 
(as in dotted notes in a score). 
 
 
 
 
 
 
 
 
 
 

Volume of the pattern playback and an accompanying click track can 
be set with the sliders. This volume slider is the master slider for all 
audio in Groove Detective. 

 
The most important tool for the searches in this section is the Slop control. 
This determines how close in timing a potential loop candidate must be to 
the target pattern to be considered a match. 

 
This value applies to all the hits in the pattern, unless otherwise specified. See 
description of Slop Handles. This value specifies time in PPQ, and if a candidate hit is 
within this interval ahead of or behind the target hit, it is considered to be a match. 
 
You can set this value by either typing directly in the box, use the spin arrows in 1 
increment or use the mouse scroll wheel in 5 increments. 
 
Finally, when you’re ready to search, hit the Search button. 

 
 

 

The Edit Window 
 
Before we describe the various editing tools, it’s important to first explain a central 
concept in how searches are carried out. Basically, the system allows you to work with 
two different types of hits: Match and Don’t Care.   
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Match hits requires that a matching hit must be present in the candidate (within 
slop intervals) in order for the pattern as a whole to be a match. 

 
Don’t Care hits you don’t need, but will allow, in the candidate pattern. A hit in 
this position will match, as will the absence of a hit. This idea is further expanded 

with Don’t Care Regions (more on this later). Together, these tools give you a great deal 
of freedom to specify ‘fuzzy’ patterns, when it’s not important that you get exactly what 
you have in the editor. 
 

The Toolbar on the right of the screen lets you select the various editing tools. 
 
They are, from top to bottom, Select, Match, Don’t Care, Delete, Mute, Slop and 
DC Region. 
 
Select let’s you focus on a hit for various editing operations (see Selected Hits).  
 
The next two red and green drumstick tools let you place Match and Don’t Care 
hits in the editor. If quantization is on, the hit will be placed on the nearest 
quantization grid line.  

 
The Delete tool removes a hit from the editor. 
 
The Mute tool stops a hit from sounding when you play the pattern and also prevents it 
from being visible in any search. 

 
Muted, not selected Match hit 
 
Muted, not selected Don’t Care hit 
 

 
The Slop tool let’s you set a slop-interval for a specific hit (see Slop Tool). 
 
The DC Region tool draws a region of time where ‘anything goes’ for a particular 
instrument (see Don’t Care Regions). 
 

Slop Tool 

If you need some hits to have a different slop value than the global one that is specified 
in the Control Section, you can do so with the Slop tool. Select the tool and click and 
hold the button down on a hit. Depending on where you clicked on it relative to the hit 
position, you can now drag the Slop Handle either to the left or right. 
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The exact position of a handle is continuously updated in the Hit Info panel to the left. 
 

 
These values are in PPQ units as it is for the global Slop value. 
 

The finer points of Slop Handles 

 
If you are new to the program you can skip this section without losing much 
functionality. If you want to become an expert – read on. 
 
There is a fixed limit on how wide you can set the slop-interval, either with the handles 
or the global control. This is currently set at 240 PPQ. There are some technical reasons 
for this limit, which may be removed in the future. 
 
If you use a handle for only one side, the other side will then still use the global Slop 
value. The semantics of the slop is otherwise exactly the same as explained above. 
 
If two hits come close together, the display of the handles changes so as to avoid screen 
clutter: 
 

For a left handle and 
 
 
 
 
for a right handle. 
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You can edit an existing handle at any time. Select the Slop tool and click and drag on 
the handle. The handle covers the time from hit position to the left or right end-bracket. 
If the handle is not shown on the time-line (illustrated above), you should zoom in until 
you see it. Otherwise, you will have to estimate where it is from the various time 
readouts. 
 
A slop-interval cannot contain another hit. So, in other words, you cannot drag a handle 
past the position of an existing hit or place a new hit within an existing slop-interval. 
 

The same is true of the handles themselves - they are not allowed 
to overlap. 
 
 

The reason for this is to remove all possible ambiguity about where the hits are 
supposed to be.  
 
Consider two hits close together with no handles as in the following example. They will 
both use the global slop value, which has no restrictions. The slop boundaries are 
indicated in the corresponding colors. 
 

 
 
In the interval from 1 to 2 the slop boundaries overlap and the search algorithms 
interpret this in this way: any two hits (or in this case, one will do as well) in this interval 
will match, no matter what their relative timing is. With Slop Handles you can force 
separation between the two hits. 
 

Selected hits 

 
You can select an existing hit with the Arrow tool. 
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When a hit is selected, it gets a white center. Information about this 
hit will appear in the Hit Info panel.  
 
 

 

 
 
If a hit is selected you can do a few more things to it. 
 
By using the mouse scroll wheel, you can raise or lower the amplitude of the hit for 
playback purposes.  
 
You can nudge the hit backwards and forwards in time in small increments (5 PPQs) with 
the “-“ and “+” keys on the numeric keypad.  The regular keyboard +/- keys will not 
work. 
 

You can move a hit by clicking and dragging it to a new position. The new 
hit position will show as a grayed hit as you move the mouse. The 
Quantization grid will not affect where you move the hit. 
 

 
You cannot move the hit past one to the left or right of it or past any of the limitations 
as explained above (Slop Handles). Also, you cannot change its instrument designation 
(no up or down between the tracks). 
 

Don’t Care Regions 

 
In the Instrument Section, clicking on the instrument button makes the program ignore 
all hits for that instrument when doing a search. This is indicated with a cross-hatch 
pattern filling up the lane. 
 
Don’t Care Regions (DC Regions) takes this idea one step further and allows you to 
specify stretches of time where you don’t want the matching algorithms to do any 
matching.   
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This facility can be extremely useful in many situations. Sometimes drummers play with 
a ‘flam-style’, i.e. they let the stick bounce lightly before or after the ‘real’ hit, creating a 
double or even triple hit for a single stroke. If you use the single hit tools you would not 
match those patterns unless you sprinkled a lot of DC hits around, a tedious and time-
consuming process. The DC Region solves this problem by allowing any number of hits 
to pass through. 
 
Another situation where this tool comes in handy is patterns with a prominent room 
slap-echo present. The analysis algorithms cannot always distinguish a real hit from its 
echo (at least not very quickly), so the pattern can end up with ‘ghost’ hits in the 
database. Use the DC Region to get around this problem. 
 
Finally, use it just to experiment. Throw up some regions where you want to see 
something happening and see what comes back! 

 
You can draw a region over existing hits. The hits will be ‘hidden’ 
by the region (just as with Instrument Mute). 
 

 
Edit Region: Place the DC Region cursor inside an existing region, left-click and move.  
 
Delete Region: Start the edit and then move the cursor past the beginning point to the 
left. The region will be deleted. 
 

Double/triple hits 

 
The analysis algorithms do not attempt to separate two hits that occur at 
the same time. In these cases, the hit with the lowest frequency center 
will be chosen as the hit. 
 
If you present a double (or triple) hit to the search, the topmost hit(s) 
will be removed before proceeding with the search. 
 
The hit in the Hat track (left) will not be visible to the database search. 
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Edit menu 
 

The following options are available from the Edit 
Menu. 
 
Clear Pattern removes all the hits from the Pattern. 
Remove DC Regions removes all DC Regions from 
the Pattern. 
Quantize applies quantization to all the hits with the 
currently active setting in the quantize control. 

 

The Instrument Section 
 
To the left of the edit area is the Instrument Section that is divided into the three 
instrument ‘tracks’. 

Mute On - Off: Hat / Snare / Kick 

You can turn any Instrument on and off with this button. When it’s off, all the hits will 
not sound in playback nor will they have any effect on any search. For example when 
HAT is clicked the track will be muted like this: 
 

 
 

Volume Faders 

 
Individual instrument volume faders let you set the relative levels during playback 
 
 

Load new sounds (all instruments) 

 
Click on Open File for instrument 
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This option will let you browse for a new instrument sound. This sound will then be used 
in the pattern playback and also be the primary sound template for the similarity 
matching. See Similarity.  
 
A collection of kick, snare and hat sounds was included in the installation (see Sound 
Sets). 
 

Default Sounds 

 
When the program starts it loads a set of default sounds from the Sounds folder located 
in the Data folder. If you want a different set of default sounds you can replace these 
files, but make sure that they are named exactly the same: 
KickGD.wav 
SnareGD.wav 
HatGD.wav 
ClickLo.wav 
ClickHi.wav 
 
Ideally they should be 16 bit, 44.1 KHz, mono files, but other formats will work too. 
 

Similarity 

 
For each of the instruments you can set a percentage of how much you want 
the target sound to be similar to the corresponding instrument sound in the 
search results. At 0 % any sound will match and at 99% you want it to be as 
identical as possible.  
 
Whatever sound you have loaded for that instrument track will serve as the 
template for the search matching algorithms. 

 
In this example the snare needs to be matched with similar sounding snare hits at 42%, 
which would normally mean something like “somewhat similar”. 
 
Note that this number is only meant as an approximation and may change precise 
meaning from sound to sound and search to search.  
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Amplitude 

 
The last item in the Instrument Section is a set of Amplitude Threshold 
settings. 

 
This defines a lower threshold when comparing hit amplitudes in the search. If a 
candidate hit has lower amplitude than this setting it will not be considered to be a 
match in the search. This lets you filter out loops with ‘ghost’ hits that don’t contribute 
to the groove you’re after. 
 
This setting has no effect on Don’t Care hits. 
 
The default value of –43dB is a conservative starting point. It lets all but the most 
ephemeral hits through in the search. 
 

Recording 
 
You can enter a pattern with live recording from Midi. The input device and channel is 
set in the Options dialog. The note-to-drum mapping follows a standard General Midi 
layout. 
 
You can also use your computer’s keyboard to record. The current input method does 
not acquire keystrokes with a fixed latency, unfortunately, so your mileage using this 
feature may vary considerably. This will be fixed in a future release. 
 

To start recording, press the Record button and play your Midi controller 
or hit the assigned keys to place the hits in time. 
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Search Results 
 
At the bottom you will find the search results, if any, after you hit the Search button. 
 

 
 
You can audition any of these loops by using the associated Play and Stop buttons. To 
use them in your DAW you can click on either the File name or the Path and drag the 
loop into an appropriate place in that program (assuming it accepts dropped files, which 
most do). 
 
The following information is displayed for each loop: 
 

 

 
 
File is the loop’s filename. 
Path is where you’ll find it in your system 
Type is one of the file-types you have checked in the File Options (see Search Folders). 
Tempo is the loop’s tempo in BPM. 
Pitch is a measure of the degree to which pitched sounds are present in the loop. This 

goes from a value of 0, no pitch detected, to 1, max pitched. (Pitch and 
Instrumental Loops) 

Rate is the sample-rate of the audio. 
Bits is the bit-depth of the audio. 
Chan is the number of channels (1 or 2). 
Dur is the duration in seconds. 
Last modified is the date and time the file was last touched. 
Bars is the number of bars/measures in the loop. 
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Sort and filter 
 
You can sort on any of these categories simply by clicking on the column header. Clicking 
repeatedly will switch between ascending and descending sort. You can further refine 
your results by using the Filter menu. 
 

 
 
In the Text Filters sub-menu you can filter on text in various ways: 
 

 
 
The Value Filters sub-menu will show you a list of all the different values that are 
currently present in that category and lets you check off which you want or don’t want 
to see. 
 

 
 
You can clear a category’s filter by selecting Clear Filter From … from the main Filter 
menu. To clear all the filters, go to the Edit menu and select Reset Result Filters. 
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Browse Path folder 
 
When creating loop collections, almost all producers make up a healthy batch of useful 
variations on the basic rhythm for a particular groove and place all of these in the same 
folder for easy perusal.  With GD you can take advantage of this practice. When your 
mouse is over the path column of a loop that you would like to explore more, click the 
right button and a custom browser will show all the loops that are in that same folder. 
 

 
 
 

 
 
This browser is not a dialog box. It will stay open until you close it or exit the app. You 
can have as many of these open as you want, experimenting with different 
combinations using the playback facilities. 
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Pitch and instrumental loops 
 
You are more than likely to have instrumental loops mingled in with your drums and 
percussion loops in your library. By ‘instrumental’ we mean loops containing musical 
segments with bass, piano, guitar, brass and any other melody-carrying instrument. 
Groove Detective tries to eliminate as many of these from the database as possible, as 
the focus here is solely on drums and percussion. 
  
When GD analyzes the audio it computes a measure of how much pitch is present. It 
also tries to determine whether that ‘pitchiness’ is due to a pitched percussion 
instrument or if it is something else. Combining these results it will then exclude from 
the database any loops that is judged to not be a drum/percussion loop. 
 
There is no way to make a perfect call on this since there is a large zone of ambiguity 
that even a human listener would have difficulty classifying. The approach taken by GD 
is a very relaxed one, which means that only the most obviously instrumental loops will 
be excluded. These are all listed in “log.txt” in the Data folder after you have completed 
analysis. 
 
This also means that, in all likelihood, a number of actual instrumental loops will show 
up in your searches from time to time, but that’s the nature of the beast. In a future 
version of Groove Detective we will provide some parameters to the user that can be 
used to change how tight the pitch restriction should be. For now, it is hard-coded into 
the program.  
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Search Examples 
 

 A standard rock groove with 8th-note feel in the hi-hat: 
 

 
 
 

 The same, but with anything and everything allowed for the hi-hat: 
 

 
 
 

 A conga groove with no kick drum and a wide range of variations allowed.  
 

Before searching, load the appropriate sounds into the snare and hat tracks, 
e.g. a mid-frequency full hit and a high non-pitched slap. Then set similarity to 
a high value (70-99). 
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 Use the Slop Handles to restrict the search range for a particular hit to a narrow 
range. 

 

 
 
 

 Find all loops with no kick drum in them.  
 
WARNING! When you cast the net this wide you will get very little assistance from the 
database index system. You’re basically asking it to look at almost everything you have, 
so a search like this could take a long time to complete. 
 

 
 
 

 A strong “Four on the Floor” search. To make sure only very strong hits are 
considered; increase the Amplitude Threshold to a fairly high level. 

 

 
 
 

General hints and recommendations 
 
When you’re looking for acoustic drum loops played ‘live’, it is more often than not a 
good idea to disable Hat matching. 
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Unless the hihat is fairly high in the mix and played very distinctly, chances are good that 
the analysis will have missed hits here and there and your search can be thrown off 
track by irrelevant details in that department. Use the Hat when searching in MIDI files 
(no ambiguity there) or a specific high frequency percussion rhythm pattern. 
 
When you have something specific in mind you probably want to start your search 
there, say something like this: 
 

 
 
It gets a few matches, but you suspect there might be more of interest out there. 
Choose a hit you could think of as more of an accent hit and make it Green. 
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Making just one hit Green expands your results considerably in this case. If you could 
listen to all of these you’d find they are all still right on the money and maybe you’re 
already done.  
 
But what if you could bring in the fringes and the ones that were not analyzed correctly? 
Your best bet is to try a hit and miss strategy. Start sprinkling Green hits where you think 
they might act as accents or be just accidents. It doesn’t take long to experiment and 
you might be surprised. Here is one such result: 
 

 
 
By adding just 3 more Green hits, we found quite a few more loops that were pretty 
close to what we were looking for in the first place. 
 
Finally, going even more out on a limb, replace some of the hits with DC Regions and 
see what happens. 
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In this case, we got a large number of extra candidates, many of which will no doubt be 
of no interest in the current context. Remember to use the Amplitude Threshold and 
Similarity tools to trim a large result list back down! 
 
 
Double/half tempo 
 
An area that the analysis can have problems with (and humans too), is to determine 
exactly what beat-division constitutes a quarter-note and hence, a full measure. As an 
alternative to what you think it is, try to double or halve the tempo and space the hits 
accordingly so that the pattern sounds identical. You might get some more search hits 
this way.
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Theory 
 
Groove Detective uses sophisticated, state-of-the-art analysis algorithms to achieve its 
results. This does not in any way mean that it makes any claim to be 100% correct, 
however. It is not possible, even in theory, to be that accurate. 
 
Consider a short burst of white noise audio used as percussion. What is it? Your brain 
will interpret that sound according to where it fits into previous memory, but there 
cannot be any objective instrument classification of it, by definition. 
 
There are countless variations on this conundrum in the audio world and GD does not 
pretend to have solutions for all of them. You should also bear in mind that, for this 
release, most of the attention has been focused on traditional, acoustic drum kits. The 
further away from this the individual sounds get, the more likely you are to encounter 
errors. This is also true for heavy signal processing, like reverb, echo, compression etc. 
 
While still trying to be as objectively correct as possible, the main goal of GD is not 
transcription accuracy, but usability. Even if you miss some loops you should have seen 
or got some that were clearly wrong in your search results, the point of having this tool 
is to be able to get to at least a significant chunk of your library that would otherwise lie 
fallow.  
 
When you have the inspiration for some new music flowing and you need a good-
sounding backbone to support it, punch your sense of it into GD and you’ll have 
something going within 30 seconds instead of getting 30 minutes of frustration moping 
around folders trying to remember where you once found something similar. In 
addition, you might also accidentally stumble on a variation you might not otherwise 
have thought of. Serendipity rules! 
 
 
 
 
 
 



Keyboard shortcuts Page 43 

Keyboard shortcuts 
 
NumPad * Start record 
NumPad 0 Stop play/record (pattern only) 
NumPad - Nudge back 
NumPad + Nudge forward 
  Space Start pattern play / stop (any) playback 
Alt +  Del Clear pattern 
Alt +  S Search 
  F1 Arrow tool 
  F2 Match tool 
  F3 Don’t Care tool 
  F4 Delete tool 
  F5 Mute tool 
  F6 Slop tool 
  DEL Delete selected hit 
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FAQ 
 

What is PPQ? 
 
PPQ is an acronym for “Pulses Per Quarter-note” and has been the standard way of 
specifying the time resolution of MIDI-sequencers since the early days. As the name 
implies, it is independent of absolute time – whatever you designate as a Quarter Note 
will be further subdivided into PPQs and that will be your smallest unit of time. Of 
course, you can increase the tempo and alter the time signature so that this will exceed 
any hardware capability you have, but that’s another story. 
 
In Groove Detective, PPQ is set to 960, which is a fairly universal setting for MIDI these 
days. Certainly, in the context of what you would ever want to do with GD, we seriously 
doubt you would ever need a finer resolution than that. 
 

Why only one bar in the Editor? 
 
Think of an 8 bar pattern you might want to look for where each bar is different. No? 
Think of a 4 bar pattern – that’s probably your own song or you’re a studio session 
drummer. In cases like these, one is most likely looking for just one, very specific loop. 
However, GD is not set up to do these kinds of exact searches that you would otherwise 
find in commercial database systems (like banks). The overriding goal here is to 
generate a collection of candidates that might fit the need of the moment and having 
this kind of specificity runs counter to that. 
 
You could, however, make a case for a 2 bar pattern and that is certainly something we 
will look into as we move forward. 
 

Why only DirectX audio? 
 
We thought long and hard on the issue of including audio drivers like ASIO in this 
version. The main reason we didn’t was that we didn’t feel it added any value to the 
program. 
 
Groove Detective is not meant to be part of the sound production chain. It is meant to 
sit on the sideline and be a helper when the need arises. As such, it should have a non-
intrusive sound-device policy and DirectX delivers on that issue very well. 
We are open to other opinions on this though…. 
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Sound sets 
 
A small collection of sounds has been included with the installation. They are all in the 
Sounds folder in the Data folder. 
 
The sound files in that folder itself are the default sounds for the Pattern Editor as 
described in Default Sounds. 
 
In the MIDI subfolder are all the sounds used for MIDI playback in the program. These 
are all GM numbered/named and can be replaced as described for the Default Sounds. 
 
In the Kick, Hat, Snare and Perc subfolders are some examples of sounds that might aid 
you in searching for that specific feel you’re thinking of (see Similarity). 
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License Center 
 

The licensing system has been designed to provide the user 
with the maximum flexibility in how to run the program. When 
you purchase a license for Groove Detective you get the right 
to run that program on any computer, anywhere in the world, 
at any time. The License Center is here to make that process as 
painless as possible. 

 
After you have successfully activated the program, you can access the License Center 
anytime from the File menu: 
 
The LC dialog comes up: 
 

 

Activate new license 
 
This is described at the beginning of this manual, page 5. 
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Activation Key 

 
The Activation Key is the key used for activating the program and it is 
also used for transferring licenses between machines (both need to be 

online, see below). 
 
When you first activated the license, you may have noticed that the Save (to Registry) 
button became active: 
 

 
 
This option allows you to save the Activation Key to a hidden location in the Registry, so 
you don’t have to hunt for it in your email box or a file somewhere every time you need 
to transfer the license. This location is extremely difficult to find, but not impossible, so 
unless you are very paranoid about someone else snooping around on your computer 
and copying the Key, we recommend using this option. If you didn’t save it during 
activation, you can do so at any time. Just paste it into any of the two Activation Key edit 
fields and click Save. If, for any reason, you wish to remove it from the Registry, click on 
the Remove button: 
 

 
 
 

Automatic license transfer 
 

When both machines to be transferred from and to are connected to the Internet, the 
easiest way to do the transfer is to use this method. 
 
If you had previously saved the Activation Key to the Registry, you will have the option 
of reading the Key from there when transferring out. Make sure the checkbox has a 
check-mark to use it. 
 

Alternatively, paste or type the Key in. When the Key is available, the 
Transfer button will be enabled.  
 

Click on it to transfer the license out (assuming it was on that machine to begin with).  
 
You’ll know that the transfer is going to go OUT if the RUN button is 
currently shown: 
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If the transfer was successful you will get the following message: 
“TRANSFER COMPLETE”. 

 

 
 

Also, since this machine now no longer has a valid license to 
run, the RUN button will have turned into an EXIT button: 
 
 

 
Your only options now are to exit the program or transfer the license 
back in. 
 
On the second, destination machine, run Groove Detective. It will come 

up with the License Center displayed. Unless it is still in the 30 day evaluation period, it 
will have the same Exit button. Paste or type in the Activation Key (or use the Registry) 
and click Transfer. You should see the “TRANSFER COMPLETE” message and EXIT turn 
into RUN. 
 
 

Manual license transfer 
 
If, for some reason, the Internet is not available on both machines, it is possible to 
transfer the license by “paper and pen”.  
 
First, get the Registration ID of the target machine. You will find this ID string near the 
bottom of the LC dialog. 
 

 
 

On the source machine: 

 
Type or paste in the Registration ID string of the machine you are transferring to: 
 

 
 
 
The Transfer OUT button will be enabled. Click on it to transfer out. 
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This will generate a new License Key that can be used on the destination machine. It is 
crucial that this string is copied before closing down the LC. You will get this warning: 
 

 
 
Click OK and copy the License Key to a file or a piece of paper. 
 

 
 
The license has now been effectively removed from the source machine. 
 
 

 
The RUN button has turned into EXIT: 
 
 

 
 

 

On the destination machine 

 
Paste or type in the License Key: 
 

 
 
 
The “Transfer IN” button will be enabled: 
Click on it to complete the process. 
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Emergency License 
 

In addition to the regular license, Groove Detective also 
provides 5 emergency licenses, good for 7 days each, in case 
something goes wrong with the transfer process. This can 

happen if the activation server goes down in the time between transfer OUT and 
transfer IN.   (Servers have scheduled downtime for maintenance on a regular basis, so 
this is not an unlikely scenario.) 
 
If a license has been transferred out, the “Use emergency license” button will be 
enabled. 
 
Click on it to activate a license for 7 days. 
 
 
 

 
 


	TABLE OF CONTENTS
	Installation and License
	Data folder

	Introduction
	Getting started
	Analyze
	Search
	…and play

	Setting Options
	Search Folders
	File Types

	Audio
	Midi

	Database and Analysis
	Common GUI Elements
	Waveform Display
	Bar Edit
	Edit Bar Markers

	Pattern Editor
	Pattern Control Section
	The Edit Window
	Slop Tool
	The finer points of Slop Handles
	Selected hits
	Don’t Care Regions
	Double/triple hits

	Edit menu
	The Instrument Section
	Mute On - Off: Hat / Snare / Kick
	Volume Faders
	Load new sounds (all instruments)
	Default Sounds
	Similarity
	Amplitude

	Recording

	Search Results
	Sort and filter
	Browse Path folder

	Pitch and instrumental loops
	Search Examples
	General hints and recommendations

	Theory
	Keyboard shortcuts
	FAQ
	What is PPQ?
	Why only one bar in the Editor?
	Why only DirectX audio?

	Sound sets
	License Center
	Activate new license
	Activation Key

	Automatic license transfer
	Manual license transfer
	On the source machine:
	On the destination machine

	Emergency License


